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Preface 

Using Oracle Cloud Adapter for SuccessFactors describes how to configure the SuccessFactors 

Adapter as a connection in an integration in Oracle SOA Suite. 

This section consists of the following topics: 

 Audience 

 Related Resources 

 Conventions 

Audience 

Using Oracle Cloud Adapter for SuccessFactors User Guide is intended for those who wish to use 

the Adapter for integrating Applications with SuccessFactors. 

Related Resources 

For more information, see these Oracle resources: 

 Developing SOA Applications with Oracle SOA Suite 

 Administering Oracle SOA Suite and Oracle Business Process Management Suite 

 Administering Oracle Service Bus 

 Understanding Technology Adapters 

Conventions 

The following text conventions are used in this document: 

Convention Meaning 

boldface 

 

 
italic 

 

 
monospace 

 
Boldface type indicates graphical user interface elements 

associated with an action, or terms defined in text or the glossary. 

 

Italic type indicates book titles, emphasis, or placeholder 

variables for which you supply particular values. 

 

Monospace type indicates commands within a paragraph, URLs, 

code in examples, text that appears on the screen, or text that you 

enter. 
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Introduction to the SuccessFactors Adapter 

This section introduces the SuccessFactors Adapter. 

This chapter consists of the following sections: 

 Oracle Cloud Adapter for SuccessFactors 

 What Application Version Does the SuccessFactors Adapter Support? 

 Installing the Cloud Adapters 

 Performing Postinstallation Configuration Tasks 

 Disabling Hostname Verification 

 Obtaining the Authentication Credentials 

 Unsupported Features 

Oracle Cloud Adapter for SuccessFactors 

The Oracle Cloud Adapter for SuccessFactors enables you to create an integration with 

SuccessFactors cloud-based human capital management (HCM) software using the Software as a 

Service (SaaS) model. 

The Oracle Cloud Adapter for SuccessFactors supports SFAPI (SuccessFactors API) exposed by the 

SuccessFactors application. Hence, giving exposure to only the business objects that can be 

accessed via SFAPI. 

The Oracle Cloud Adapter for SuccessFactors is one of the many predefined adapters included with 

Oracle SOA Suite. The SuccessFactors adapter is configured as an external reference in Oracle SOA 

Suite.For more information, see Configuring Oracle Cloud Adapter for SuccessFactors 
Properties. 

What Application Version Does the SuccessFactors Adapter 

Support? 

The SuccessFactors Adapter is compatible with SuccessFactors version SFAPI 1.2 as well as 1.1. 

Installing the Cloud Adapters 

See the README.txt available with the patch for instructions on installing the cloud adapters. 

After you complete the adapter installation, perform the tasks described in Performing 

Postinstallation Configuration Tasks. 

Note: For information about supported versions and platforms, see the release certification 

matrix at Supported System Configurations. 
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Performing Postinstallation Configuration Tasks 

You must perform post-installation configuration tasks after installing the cloud adapters. 

For information about post-installation configuration tasks, see the Oracle Cloud Adapters 
Postinstallation Configuration Guide. 

Disabling Hostname Verification 

By default, the WebLogic Server Configuration Wizard sets Hostname Verification to be a 

Hostname Verifier when creating the Oracle SOA Suite and Oracle Service Bus domains. 

Hostname Verification must be set to None for the Oracle Cloud Adapter for SuccessFactors to 

work. To disable hostname verification, follow the steps mentioned below: 

1. Log in to the Oracle WebLogic Server Administration Console. 

2. Under Domain >Environment >Servers, double-click the server name. 

3. Click the SSL tab. 

4. Under Advanced, update Hostname Verification to None. 

5. Save the change. 

Obtaining the Authentication Credentials 

Obtain the user name and password that are required for creating the Credential Store Framework 

(CSF) authentication key in Oracle JDeveloper and Oracle Enterprise Manager Fusion Middleware 

Control from your SOA domain administrator. These credentials are required for most cloud 

adapters. For the Oracle Cloud Adapter for SuccessFactors, the credentials require three properties 

(companyID, username, and password). 

Unsupported Features 

 The Oracle Cloud Adapter for SuccessFactors cannot be configured as exposed service. 

 The Oracle Cloud Adapter for SuccessFactors does not support Odata API exposed by 

SuccessFactors.  
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Understanding Oracle Cloud Adapter for 

SuccessFactors Features 

This chapter consists of the following topics: 

 Prerequisites for Creating a Connection 

 Designing an Integration with the Adapter Configuration Wizard 

 Monitoring Your Application During Runtime 

 Uploading an SSL Certificate 

Prerequisites for Creating a Connection 

You must satisfy the following prerequisite to create a connection with the SuccessFactors Adapter: 

 Purchase a subscription to SuccessFactors. When you subscribe, you receive a company ID, 

username, and password. The information is required to configure the connection page of 

the SuccessFactors Adapter configuration wizard for establishing a connection to the 

SuccessFactors Application. The Connections page includes an SFAPIWSDL location 

(WSDL URL). This WSDL location represents your API endpoint, which depends on 

where your SuccessFactors instance is located. It can be in one of several data centers. 

Contact your SuccessFactors representative if you are unsure of which data center to use. 

Designing an Integration with the Adapter Configuration 

Wizard 

You use the Adapter Configuration Wizard to include the Oracle Cloud Adapter for SuccessFactors 

in a SOA composite application or an Oracle Service Bus business service. 

The Adapter Configuration Wizard consists of configuration pages that enable you to select 

Operation and Object. The required artifacts are generated after the wizard completion. These 

artifacts are utilized in runtime to communicate with the SuccessFactors application. You can 

configure the adapter in the External References (outbound). 

The Basic Info page prompts you to enter a meaningful name and optional description. 
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The Connection page prompts you to specify the WSDL URL (for example 

https://salesdemo4.successfactors.com/sfapi/v1/soap12?wsdl), the security policy and authentication 

key to use. The authentication key is created by clicking the Add icon to specify the key name, 

Successfactors companyId, user name, and password. You must also specify these same values in 

Oracle Enterprise Manager Fusion Middleware Control. For instructions, see the Oracle Cloud 

Adapters Postinstallation Configuration Guide. 

 

The Operations page prompts you to select the Operation Type, Operation Name and the 

business object on which the specified operation is to be applied.  

Operation type and Operations Supported: 

 CRUD: Displays the insert, upsert, update, and delete operations that can be performed on 

SuccessFactors business objects. The Available section contains the business objects which 

https://salesdemo4.successfactors.com/sfapi/v1/soap12?wsdl
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support the selected operation. Select the operation name and the business object on which 

to perform the operation. 

 SFQL (SuccessFactors Query Language): Enables you to define an SFQL-based query to 

send a request for querying a particular business object and retrieve the respective object’s 

information. If you select this option, the page is refreshed to display a text box for entering 

a query. 

 

The Summary page displays your selections for the outbound direction. 

 

The following artifacts are created for each adapter instance in the Applications window in Oracle 

JDeveloper: 

 WSDL file: Only the standard WSDL file type is supported. 

 JCA file: Contains the internal implementation details used by the adapter during runtime. 

It contains the different interaction and connection properties used by the adapter. When 
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application configuration is complete, you can deploy the application from Oracle 

JDeveloper to the runtime environment. 

For information about the details to specify in the fields of the wizard pages, see Configuring Oracle 

Cloud Adapter Connection and CSF Key Properties. 

Monitoring Your Application During Runtime 

This section describes the design time and runtime aspects of using the Oracle Cloud Adapter for 

SuccessFactors. You use the runtime part of the adapter for delivering the information generated 

during design time to the service endpoint. You can monitor your SOA composite application or 

Oracle Service Bus business service from Oracle Enterprise Manager Fusion Middleware Control. 

You can also test your Oracle Service Bus business service from Oracle Service Bus Console. 

Uploading an SSL Certificate 

Certificates are used to validate outbound SSL connections. If you make an SSL connection in 

which the root certificates do not exist in Oracle SOA Servers, an exception is thrown. In that case, 

you must upload the appropriate certificates. A certificate enables Oracle SOA to connect with 

external services. If the external endpoint requires a specific certificate, request the certificate and 

then upload it into Oracle SOA Servers. 

Generating SuccessFactors Certificate 

The SuccessFactors Client certificate has to be downloaded from the SuccessFactors application 

user interface. This certificate has to be imported into the server for successful handshaking with 

Successfactors. The Oracle Cloud Adapter for Successfactors uses two-way SSL when interacting 

with Successfactors and hence requires this certificate. On the WebLogic server, these certificates 

are required to be imported. 

To download the certificate, use the following procedure: 

1. Log in to the Successfactors using a valid user companyId, username and password. 

 

2. Click on the lock icon as indicated in the above figure. A small window will pop up. Click on 

the view certificates as indicated in the figure below. 
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Note: Here, Google Chrome is used for demonstration. Experience may differ if you will be 

using other browser or other version of internet explorer. But idea here is to click on security 

lock to fetch the certificate information. 

3. After clicking on the view certificates another window pops up providing the details of the 

certificate. Open the Certification Path tab and select VeriSign as shown in the screenshot 

below. The View Certificate button would be enabled, click the same to view certificate 

details. 
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4. A new page opens above the existing page, open the Details tab and click on Copy to File 

button. 

  

5. Now, Certificate Export wizard opens. Click on next button and select Base-64 encoded X.509 

(.CER) option. 
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6. Click Next and browse to the location where you want to save the certificate. Provide an 

appropriate name to the certificate file and save it. 

7. Double-click and open the Saved certificate.  

8. Follow the same procedure for remaining two certificate paths.  

9. Import the downloaded certificates into your application server, and configure your application 

server to request the client certificate. The application server then checks that the certificates 

used in the SSL/TLS handshake matches the one you downloaded. 

Importing SuccessFactors Certificate using Keytool 

1. Provide a suitable location on your system to save the certificates authority. You would now 

add these certificates to Keystore. 

2. Make sure that KSS for demo is disabled.  

3. To disable KSS, go to the WebLogic console (http://url:port/console/). 

4. Click on Domain  Security  Advanced page and unselect “Use KSS for Demo”.  

5. Click Save.  

6. To know the WebLogic server’s trust Keystore location: On the home page, proceed to Servers 

under Environment subsection.  

7. Select the Admin server out of the list of servers displayed.  

8. Proceed to the Keystores tab, as shown in the figure below. 

http://url:port/console
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9. Under Keystores tab, select the Demo Trust Keystore path. This is the path where our 

keystore resides. 

10. It would be of the form {Middleware_Home}/wlserver/server/lib. Next, you need to import this 

certificate from the authority into WebLogic server’s trust store.  

11. If you are using a window based system, use a command prompt to navigate to the path 

mentioned in the above step.  

12. At this path, run the following keytool command:  

keytool -import -trustcacerts -alias SuccessfactorsCA –file 

<Filename with location> -keystore DemoTrust.jks -storepass 

DemoTrustKeyStorePassPhrase  

For e.g., assuming downloaded certificate is kept at the location as mentioned in the step 8 

and name of the certificate is Successfactors.cer then keytool command would look like: 

keytool -import -trustcacerts -alias SuccessfactorsCA –file 

Successfactors.cer -keystore DemoTrust.jks -storepass 

DemoTrustKeyStorePassPhrase  

13. A message Certificate was added to keystore is displayed, which confirms the successful 

import of the certificate. If you get a ‘Certificate already exists in the Keystore message’, enter 

‘Y’(yes) and proceed to import the certificate. 

14. You can verify the same by enlisting all the certificates using the following command:  

15. keytool –list –keystore DemoTrust.jks -storepass 

DemoTrustKeyStorePassPhrase  

16. The newly imported certificate appears as part of existing certificates in the keystore. 

17. Follow the steps for 12 to 14 for other two certificates. 



 
Understanding Oracle Cloud Adapter for SuccessFactors Features  2-9  

 

 

  

18. Restart the server to bring the modifications made in the previous steps into effect. 
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Designing SOA Composite Applications 

This section describes how to design a SOA composite application with the Oracle Cloud Adapter 

for SuccessFactors. This chapter consists of the following topics: 

 Creating a SOA Composite Application 

 Adding an Adapter to a SOA Composite Application as a Reference 

 Completing Design of a SOA Composite Application 

Creating a SOA Composite Application 

This section provides an overview of how to create a SOA composite application in which to 

include the adapter as an exposed service or external reference. 

1. Start Oracle JDeveloper. 

2. From the File menu, select New >Application. 

3. In the New Gallery dialog, select SOA Application from the Items list, then click OK. The 

SOA Create SOA Application wizard is displayed. 

4. Specify an application name, and click Next. 

5. Specify a project name, and click Next. 

6. Select Composite with BPEL Process, and click Finish. 

The SOA composite application is displayed for designing in the SOA Composite Editor. 

Adding an Adapter to a SOA Composite Application as a 

Reference 

You can add an Oracle Cloud Adapter for SuccessFactors to a SOA composite application as an 

outbound (target) reference to the External References swimlane in Oracle JDeveloper. 

1. Go to the Component Palette in your SOA composite application. 

2. Go to the Cloud section under Custom/Third Party. 

The adapters are displayed. 
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3. To create an outbound (target) reference, drag the adapter to the External References swimlane, 

and see the following sections that describe the wizard pages for configuring the adapter. 

 Configuring Basic Information Properties 

 Configuring Oracle Cloud Adapter Connection and CSF Key Properties 

 Configuring Oracle Cloud Adapter for SuccessFactors Target Operations Properties 

 Reviewing Configuration Values on the Summary Page 
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Completing Design of a SOA Composite Application 

This section provides an overview of how to complete design of your SOA composite application 

and deploy the application. 

1. Design the remaining contents of your SOA composite application. For example: 

 Connect the BPEL process to the adapter. For this example, the BPEL process is connected 

to the adapter as an external reference. 

 Design the contents of the BPEL process. For example: 

a) Double-click the BPEL process. 

b) Add and configure an invoke activity to invoke the adapter. 

c) Add and configure assign activities to copy the contents of one variable to another when 

sending and receiving messages to and from the adapter. 

d) Add and configure other activities, as appropriate. 

When complete, view the SOA composite application in the SOA Composite Editor. 

For specific information about creating and designing SOA composite applications, see Developing 
SOA Applications with Oracle SOA Suite. 

2. Deploy the SOA composite application: 

a) In the navigator, right-click the project and select Deploy>projectname. 

b) Follow the steps in the deployment wizard to deploy the SOA composite application to the 

application server. 
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Designing Oracle Service Bus Business 

Services 

This section describes how to design an Oracle Service Bus business service with the adapter in 

Oracle JDeveloper. This chapter consists of the following topics: 

 Creating an Oracle Service Bus Business Service 

 Adding an Adapter to a Business Service as a Reference 

 Completing Design of an Oracle Service Bus Business Service 

Creating an Oracle Service Bus Business Service 

This section provides an overview of how to create an Oracle Service Bus business service in which 

to include the adapter in Oracle JDeveloper. 

1. Start Oracle JDeveloper. 

2. From the File menu, select New >Application. 

3. In the New Gallery dialog, select Service Bus Application from the Items list, then click OK. 

4. Specify an application name, and click Next. 

5. Specify a project name. 

6. Select Service Bus, and click Finish. 

The Oracle Service Bus business service is displayed for designing in the Oracle Service Bus 

Overview Editor. 

Adding an Adapter to a Business Service as a Reference 

You can add the adapter to an Oracle Service Bus business service as an outbound(target) external 

service to the External Services swimlane in Oracle JDeveloper. 

1. Go to the Component Palette in your Oracle Service Bus business service. 

2. Go to the Cloud section under Service Bus. 

The adapters are displayed. 
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3. To create an outbound (target) external service, drag the adapter to the External Services 

swimlane, and see the following sections that describe the wizard pages for configuring the 

adapter: 

 Configuring Basic Information Properties 

 Configuring Oracle Cloud Adapter Connection and CSF Key Properties 

 Configuring Oracle Cloud Adapter for SuccessFactors Target Operations Properties 

 Reviewing Configuration Values on the Summary Page 
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Completing Design of an Oracle Service Bus Business 

Service 

This section provides an overview of how to complete design of your Oracle Service Bus business 

service and deploy the application. 

1. Design the contents of your Oracle Service Bus business service. For example, to configure an 

Oracle Service Bus proxy service in your business service: 

a) In the Oracle Service Bus Overview Editor, right-click the Pipeline/Split Joins lane and 

select Insert>Pipeline. 

b) The Create Pipeline Service dialog is displayed. 

c) Enter a name for the pipeline and select the project location, then click Next. 

d) Select WSDL as the Service Type. 

e) To the right of the WSDL selection, click the Browse icon to select the WSDL. 

f) Select Application. 

g) Expand Resource Chooser and select the WSDL file, then click OK. 

h) Ensure that Expose as a Proxy Service is selected. 

i) From the Proxy Transport list, select http, then click Finish. 

The Pipeline component is displayed in the Oracle Service Bus Overview Editor. 

j) Connect the external service to the Pipeline component. 

For more information about creating and designing an Oracle Service Bus business service, 

see Developing Services with Oracle Service Bus. 

2. Open the pipeline that shows the default routing. 

3. Verify the service and corresponding operation are displayed in the Routing Properties tab at 

the bottom of the dialog. 

The outbound project is ready for deployment. 

4. Deploy the business service. 

a) Select the project, then select Deploy to Service Bus Server. 

b) Follow the steps in the deployment wizard. 
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Configuring Oracle Cloud Adapter for 

SuccessFactors Properties 

The following sections describe the wizard pages that guide you through configuration of the Oracle 

Cloud Adapter for SuccessFactors as a target in an integration. The Oracle Cloud Adapter for 

SuccessFactors cannot be configured as a source in an integration. This chapter consists of the 

following topics: 

 Configuring Basic Information Properties 

 Configuring Oracle Cloud Adapter Connection and CSF Key Properties 

 Configuring Oracle Cloud Adapter for SuccessFactors Operation Properties 

 Reviewing Configuration Values on the Summary Page 

Configuring Basic Information Properties 

You can enter a name and description on the Basic Info page of each source and target adapter in 

your integration. This section consists of the following topics: 

 What You Can Do from the Basic Info Page 

 What You See on the Basic Info Page 

What You Can Do from the Basic Info Page 

You can specify the following values on the source or target Basic Info page. The Basic Info page is 

the initial wizard page that is displayed whenever you drag an adapter to the source or target area. 

 Specify a meaningful name. 

 Specify a description of the responsibilities. 
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What You See on the Basic Info Page 

The following table describes the key information on the Basic Info page. 

 
 

 
 
 
 
 

 

Configuring Oracle Cloud Adapter Connection and CSF key 

Properties 

Enter the Oracle Cloud adapter configuration connectivity and Credential Store Framework (CSF) 

key values for your integration. This section consists of the following topics: 

 What You Can Do from the Oracle Cloud Adapter Connection Page 

 What You See on the Oracle Cloud Adapter Connection Page 

 What You Can Do from the Oracle Cloud Adapter CSF Key Page 

 What You See on the Oracle Cloud Adapter CSF Key Page 

What You Can Do from Oracle Cloud Adapter Connection page 

You can specify the following connection values for the Oracle Cloud adapter. 

 Specify the WSDL URL for some adapters.  

 Specify the security policy. 

 Create the authentication key. A key created for one direction (for example, outbound) is 

also available for selection in the other direction (for example, inbound). 

  

Element Description 

 
What do you want to call your 
endpoint? 

Provide a meaningful name so that others can 

understand the connection. For example, if you are 

creating a source Oracle RightNowCloud 

connection, you may want to name it 

RightNowInboundDirection. You can include 

English alphabetic characters, numbers, 

underscores, and dashes in the name. You cannot 

include the following: 

• Blank spaces (for example, My 

RightNowConnection) 

• Special characters (for example, #;83& 

orrigh(t)now4) 

• Multibyte characters 
 
What does this endpoint do? Enter an optional description of the connection’s 

responsibilities. For example: 
This connection receives an 

inbound request to synchronize 

account information with Oracle 

Sales Cloud. 
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What You See on the Oracle Cloud Adapter Connection Page 

The following table describes the key information on the Oracle Cloud Adapter Connection page. 

Element Description 

WSDL URL 
Specify the WSDL. The WSDL is used to build 

integrations specific to your instance. You can 

also select the WSDL from a filesystem or 

another source by choosing the browser icon next 

to the WSDL URL field. Click File System at 

the top of the dialog, then browse for the WSDL. 
Security Policy 

Select the security policy appropriate to your 

environment (for example, 

USERNAME_PASSWORD_TOKEN). 

• The wizard shows all policies, including those 

that may not be applicable. To make a correct 

selection, you must have a knowledge of policies. 

For example, you cannot select a SAML-based 

policy because the identity is not propagated. 

• The policies you apply to the cloud adapter are 

unique to the cloud adapter and do not impact 

other endpoints in the composite. 
Authentication Key 

Select the CSF authentication key. 

• Add: Click to create a new authentication key. 

You must specify the key name, username, and 

password. To successfully deploy and administer 

your application, you must specify these same 

values in Oracle Enterprise Manager Fusion 

Middleware Control. 

• Edit: Click to edit an authentication key. 

• Delete: Click to delete an authentication key. 
Test 

Click to validate the authentication key. 

 

What You Can Do from the Oracle Cloud Adapter CSF Key Page 

You can specify the following CSF key values for the Oracle Cloud adapter. 

 CSF key name 

 CompanyId for Oracle Cloud Adapter for SuccessFactors. 

 Username and Password 
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What You See on the Oracle Cloud Adapter CSF Key Page 

The following table describes the key information on the Oracle Cloud adapter CSF Key page. 

Element Description 
CSF Key Name Specify the CSF key to enable runtime 

injection of credentials. The adapter uses the 

CSF to retrieve the username and password 

required for authentication with the 

application (for example, the Oracle Sales 

Cloud or Oracle HCM application). This key 

identifies your login credentials during 

design-time. To successfully deploy and 

administer your application, you must 

specify these same values in Oracle 

Enterprise Manager Fusion Middleware 

Control. For instructions, see the Oracle Cloud 

Adapters Postinstallation Configuration Guide. 
CompanyID Note: This field is only displayed for the 

Oracle Cloud Adapter for SuccessFactors. 

 

Specify the SuccessfactorsCompanyId. 
User Name Enter the user name for connecting to your 

application (for example, the Oracle Sales 

Cloud or Oracle HCM application). Your 

administrator provides you with user 

credentials. 
Password Enter the password for connecting to your 

application. 
Re-enter Password Re-enter the same password a second time. 

 

Configuring Oracle Cloud Adapter for SuccessFactors 

Operation Properties 

Enter the Oracle Cloud Adapter for SuccessFactors target operation values for your integration. This 

section consists of the following topics: 

 What You Can Do from the Oracle Cloud Adapter for SuccessFactors Operations Page 

 What You See on the Oracle Cloud Adapter for SuccessFactors Operations Page 

What You Can Do from the Oracle Cloud Adapter for 

SuccessFactors Operations Page 

You can specify the following target operation values for the Oracle Cloud Adapter for 

SuccessFactors: 

 Select operation type 

 Select operation name 

 Select business objects 
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What You See on Oracle Cloud Adapter for SuccessFactors 

Operations Page 

The following table describes the information that is visible on the Oracle Cloud Adapter for 

SuccessFactors Operations page. 

Element  Description 

Select an Operation Type Select the type of operation to perform on the 

business objects in an Oracle SuccessFactors 

application: 

CRUD: Displays the insert, upsert, update, 

and delete operations to perform on 

SuccessFactors business objects. Select the 

operation and the business object on which to 

perform the operation. 

SFQL: (SuccessFactors Query Language) 

enables you to define an SFQL-based query to 

send a request for querying a particular business 

object and retrieve the respective object’s 

information, if you select this option, the page is 

refreshed to display a text box for entering a 

query. 

– SFQL query statement: Enter a valid SFQL 

query in the text box. The query can include 

custom fields and parameters. For example: 

SELECT guid,name FROM Goal$7 

WHERE userid = 

‘USR-22' 

– Binding Parameters: Displays any binding 

parameter, if included, in the specified query. 

For example, ‘firstname’ is a parameter in 

the following query: 

SELECT firstname,lastname FROM user 

WHERE firstname = ‘&firstname’ 

Enter a query with a parameter and press the 

Refresh button above Binding Parameters. A 

text box in which to enter a test value for the 

parameter is displayed. 

– Test My Query: Click to validate the query 

against the SuccessFactors application. The 

query response is displayed for a successful 

query. If the query is invalid, you receive a 

response for the errors in the query. 

Filter by object name Enter the initial letters of an object name to 

display a range of objects. You can also select a 

filter type: 

 All: Displays all objects available for the 

selected operation. 

 Custom: Displays objects that can be created 

in the SuccessFactors application for the 
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selected operation. 

These business objects are identified by 

special icon (‘-’). 

For example, Goal-1, DevelopmentGoal-

2002. 

 Standard: Displays business objects 

delivered as part of the SuccessFactors 

application. 

Select Business Objects 

(sfapiv1 API) 

Select a business object from the SuccessFactors 

application multiple objects are not supported). 

The selected operation acts on this business 

object. The SuccessFactors API version that is 

displayed is based on the SuccessFactors Cloud 

application version to which you are connected. 

Your Selected Business Objects Displays the selected business objects. 

What is this Object Describes the selected business object. 

 

Reviewing Configuration Values on the Summary Page 

You can review the specified adapter configuration values on the Summary page. 

This section consists of the following topics: 

 What You Can Do from the Summary Page 

 What You See on the Summary Page 

What You Can Do from the Summary Page 

You can review trigger (source) or invoke (target) configuration details from the Summary page. 

The Summary page is the final wizard page for each adapter after you have completed your 

configuration. 

 View the configuration details you defined for the trigger (source) or invoke (target) 

adapter. For example, if you have defined an inbound trigger (source) adapter with a 

request business object and immediate response business object, specific details about this 

configuration are displayed on the Summary page.  

 Click Done if you want to save your configuration details. 

 Click a specific tab in the left panel or click Back to access a specific page to update your 

configuration definitions. 

 Click Cancel to cancel your configuration details. 
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What You See on the Summary Page 

The following table describes the key information on the Summary page. 

Element Description 

Summary Displays a summary of the trigger (source) or invoke (target) 

configuration values you defined on previous pages of the 

wizard. 

 To return to a previous page to update any values, click the 

appropriate tab in the left panel or click Back.  
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Managing Applications 

This section describes how to monitor an Oracle SOA Suite or Oracle Service Bus application that 

uses the adapter from Oracle Enterprise Manager Fusion Middleware Control or Oracle Service Bus 

Console and how to verify results in the Oracle SuccessFactors Console. 

This chapter consists of the following sections: 

 Managing the Application in Oracle Enterprise Manager Fusion Middleware Control 

 Testing Oracle Service Bus Projects from Oracle Service Bus Console 

Managing the Application in Oracle Enterprise Manager 

Fusion Middleware Control 

You manage the SOA composite application or Oracle Service Bus business service that includes 

your adapter in Oracle Enterprise Manager Fusion Middleware Control. 

1. Log in to Oracle Enterprise Manager Fusion Middleware Control. 

2. In the navigator, expand the tree to display your SOA composite application or Oracle Service 

Bus business service project (for this example, a SOA composite application is selected). 

3.  Select the SOA composite application. 

4.  Click Test. 

The Test Web Service page is displayed. 

5. Complete the fields on the page to initiate a test of your composite. 

6. Click Test Web Service. 

Invocation results are displayed. 

7. Click Launch Flow Trace to view the flow trace of the SOA composite application, including 

flow details about the adapter. 

For more information about monitoring applications from Oracle Enterprise Manager Fusion 

Middleware Control, see Administering Oracle SOA Suite and Oracle Business Process 

Management Suite and Administering Oracle Service Bus. 

Testing Oracle Service Bus Business Services from Oracle 

Service Bus Console 

You can test Oracle Service Bus business service projects from Oracle Service BusConsole. 

1. Log in to Oracle Service Bus Console. 

2. In the navigator under All Projects, open the project to test. 

3. In the navigator, click the business service for that project. 
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4. Click the Launch Test Console (green arrow button) to test the outbound endpoint. 

This opens a window that displays the proxy service and the operation to test. 

5. Provide the input and click Execute. 

This sends the payload to the Oracle Cloud application. The response is displayed under the 

Response Document section. 

For more information about testing Oracle Service Bus business service projects, see 

Administering Oracle Service Bus. 
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Troubleshooting and Error Handling 

This section describes how to troubleshoot and handle errors with the adapter. 

This chapter consists of the following topics: 

 Design Time Troubleshooting and Error Handling 

 Run Time Troubleshooting and Error Handling 

Design Time Troubleshooting and Error Handling 

Test Connection Failure or Wizard Operation Page Does Not Open 

If you receive a test connection failure on the Connection page or the Operation page does not 

display in the Adapter Configuration Wizard, perform the following steps: 

 Log in to SuccessFactors directly and see if the credentials work and the SuccessFactors 

application is not down for maintenance. 

Operation Page Does Not Open Due to Out of Memory Exception 

If you get Out of Memory exception while downloading Metadata, perform the following steps: 

1. Go to the following path in the directory structure where Jdeveloper is installed: 

Jdeveloper_Home>jdeveloper>jdev>bin. 

2. Open jdev. conf and extend the Java Memory to 1GB by adding below argument at the end of 

the file: 

AddVMOption -Xmx1024M 

Run Time Troubleshooting and Error Handling 

Handling SSL Exception 

If you are getting SSL Exception in runtime with the “unable to find valid certification path to 

requested target”, check if the Certificates are added to the Oracle SOA server. Certificates are 

used to validate outbound SSL connections. If you make an SSL connection in which the root 

certificate does not exist in Oracle SOA Servers, an exception is thrown. In that case, you must 

upload the appropriate certificate. A certificate enables Oracle SOA to connect with external 

services. If the external endpoint requires a specific certificate, request the certificate and then 

upload it into Oracle SOA Servers. 


